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Product notice

This guide describes features that are common 
to most models. Some features may not be 
available on your slate.

Not all features are available in all editions of 
Windows 8. This slate may require upgraded 
and/or separately purchased hardware, 
drivers, and/or software to take full advantage 
of Windows 8 functionality. See for 
http://www.microsoft.com details.

http://www.microsoft.com


Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place 
the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do 
not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or 
rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such 
as pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-
accessible surface temperature limits defined by the International Standard for Safety of Information 
Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP Elite x2 1011 G1

Processor ● Intel® Core™ i7 M-5Y71 processor

● Intel Core i5 M-5Y51 processor

● Intel Core i3 M-5Y10c processor

Chipset Intel soldered-on chipset (SoC)

Graphics Intel HD unified memory architecture (UMA) Graphics

Panel 11.6-in, TouchScreen, full-high definition (FHD), BrightView (BV), (1920×1080), in-plane switching 
(IPS), 50% CG, typical brightness 400 nits, eDP 1.3, ultra-slim with and without digitizer

11.6-in, TouchScreen, high definition (HD), BV, (1366×768), IPS, 50% CG, typical brightness 400 nits, 
eDP 1.2, ultra-slim with and without digitizer

Memory 2 SODIMM slots DDR3L-1600MHz

Support for DDR3L-1600MHz

Support for dual channel

Supports up to 8192-MB maximum system memory

Supports 8192-MB (16-GB, 256-MB×16×4, qty 4) and 4096-MB (8-GB @ 128-MB×32×2, qty 4) 
memory configurations

Primary storage Support for M2 solid-state drive, SS 2280

Support for the following solid-state drives:

● 512-GB, M2, SATA-3 solid-state drive

● 256-GB, M2, SATA-3 solid-state drive

● 256-GB, M2, SATA-3 solid-state drive supporting TLC

● 256-GB, M2, SATA-3 self-encrypting drive (SED) solid-state drive supporting Opal 2

● 180-GB, M2, SATA-3 solid-state drive

● 180-GB, M2, SATA-3 SED solid-state drive supporting Opal 2

● 128-GB, M2, SATA-3 solid-state drive

● 128-GB, M2, SATA-3 solid-state drive supporting TLC

Audio and video 2.0-MP (1080p) front-facing webcam

5.0-MP (1080p) rear-facing webcam

Dual array microphones

HD audio with DTS Studio Sound

Stereo speakers (2)

Wireless Integrated wireless local area network (WLAN) options by way of wireless module

One built-in WLAN antenna (in display panel assembly)
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Category Description

Wireless (continued) Support for the following WLAN modules:

● Intel Tri Band Wireless-AC 17265 802.11a/b/g/n/ac 2×2 and Bluetooth 4.0 + WiGig 
Combo Adapter

● Intel Dual Band Wireless-AC 7265 802.11a/b/g/n/ac 2×2 WiFi and Bluetooth 4.0 
Combo Adapter

● Intel Dual Band Wireless-AN 7265 802.11a/b/g/n 2×2 and Bluetooth 4.0 Combo Adapter

Integrated wireless personal area network (WPAN) options supported only through Bluetooth 4.0 
combination card

Integrated wireless wide area network (WWAN) options by way of wireless module

Two built-in WWAN antennas (in display panel assembly)

Support for the following WWAN modules:

● HP hs3110 HSPA+ Mobile Broadband

● HP lt4112 LTE/HSPA+ 4G Mobile Broadband

● HP lt4225 LTE/EV-DO 4G Module

● HP lt4226 LTE/HSPA+ 4G Module

External media cards HP multiformat Micro Digital Media Reader Slot with push-push technology. Reads data from and 
writes data to digital memory cards such as Secure Digital (SD).

Ports Slate:

● Audio: one combo audio-out (headphone)/audio-in (microphone) jack, supports jack auto-
detection

● Docking (via dongle)

● Micro SD card

● Micro SIM

Keyboard base:

● Audio: one combo audio-out (headphone)/audio-in (microphone) jack, supports jack auto-
detection

● DisplayPort 1.2

● Docking (via dongle)

● HP Smart AC adapter (4.5-mm barrel)

● Smart card

● USB 3.0 (2: charging and non-charging)

Keyboard/pointing devices Spill-resistant keyboard with drain

Backlit

Touchpad requirements:

● ForcePad

● Glass with chemical etched surface

● Supports two-way scroll

● Gestures enabled by default: 2-finger scrolling, 2-finger zoom (pinch)

Power requirements Support for 65-W HP Smart adapter (non-PFC, 3-wire) and 45-W HP Smart adapter (non-PFC, RC, 3-
wire) AC adapters
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Category Description

Support for the following batteries:

Keyboard base: 6-cell, 21-WHr, 0.95-AHr, LI battery (includes cable)

Slate: 2-cell, 33-WHr, 4.56-AHr, LI battery (includes cable)

Security Fingerprint reader

Trusted Platfom Module (TPM) 1.2 / 2.0 (Infineon, soldered)

Integrated Smart card reader (active)

Full-volume encryption

Preboot authentication (password, smart card)

Operating system Preinstalled:

● Windows 8.1 Chinese 64-bit (available only with PRC country Loc)

● Windows 8.1 Emerging Markets 64-bit

● Windows 8.1 Multi-language 64-bit

● Windows 8.1 Professional 64-bit

● Windows 8.1 Professional 64-bit – MSNA

● Windows 8.1 Professional 64-bit for Education

● Windows 8.1 Professional 64-bit with Windows 7 Professional 64-bit image

● Windows 8.1 Professional 64-bit with Windows 7 Professional 64-bit image – MSNA

● Windows 7 Professional 64-bit – MSNA

● FreeDOS 2.0

Restore media – DRDVD: DRDVD Windows 8.1 (available with any Windows 8.1 loc, required with 
any Windows 8.1 Professional downgrade operating system) and DRDVD Windows 7 (available with 
any Windows 8.1 Professional or Windows 7 Professional downgrade loc)

OSDVD:

● Windows 8.1 64-bit (update, for service only)

● Windows 8.1 Country–specific 64-bit (update, for service only)

● Windows 8.1 Emerging Markets 64-bit (update, for service only)

● Windows 8.1 Professional 64-bit (update, only available and required with Windows 8.1 
Downgrade operating system. Do not include for Asia Pacific countries and regions and the 
People’s Republic of China)

● Windows 8.1 Professional 64-bit for Education (update, for service only)

● Windows 7 Professional 64-bit (available with any Windows 8.1 Professional or Windows 7 
Professional downgrade loc except in Asia Pacific countries and regions and the People’s 
Republic of China)

Certified: Microsoft WHQL

Web-only support:

● Windows 8.1 Enterprise 64-bit

● Windows 8 Chinese 64-bit

● Windows 8 Emerging Markets 64-bit

Operating system (continued) Web-only support:
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Category Description

● Windows 8 Multi-language 64-bit

● Windows 8 Professional 64-bit

● Windows 7 Enterprise 64-bit

● Windows 7 Enterprise 32-bit

● Windows 7 Professional 32-bit

Serviceability End user replaceable parts: AC adapter
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2 External component identification

Slate edge components

Item Component Description

(1) Internal microphone Record sound.

(2) Vents Enable airflow to cool internal components.

NOTE: The slate fan starts up automatically to cool internal 
components and prevent overheating. It is normal for 
the internal fan to cycle on and off during routine operation.

(3) Rear-facing webcam Records video and captures photographs. Some models 
allow you to video conference and chat online using 
streaming video.

For information on using the webcam, select Start > All 
Programs > Communication and Chat > HP Webcam.

(4) Camera flash Provides light for rear-facing webcam photos.

(5) Rotate lock button When the slate is on, press the rotate lock button to lock 
the autorotate feature of the display. To unlock 
the autorotate feature, press the button again.

(6) Volume button Controls speaker volume on the slate.

● To increase speaker volume, press the + edge of 
the button.

● To decrease speaker volume, press the – edge of 
the button.

(7) Pen holder (select models only) Holds the digital pen.

(8) Alignment post connectors (2) Align and attach the slate to the keyboard.
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Item Component Description

(9) Docking/adapter port Connects the slate to the keyboard, or as a slate only, 
connects an optional adapter.

(10) Audio-out (headphone)/Audio-in (microphone) jack Connects optional powered stereo speakers, headphones, 
earbuds, a headset, or a television audio cable. Also connects 
an optional headset microphone. This jack does not support 
optional microphone-only devices.

WARNING! To reduce the risk of personal injury, adjust 
the volume before putting on headphones, earbuds, or a 
headset. For additional safety information, see 
the Regulatory, Safety, and Environmental Notices. To access 
the user guides, select Start > Help and Support > 
User Guides.

NOTE: When a device is connected to the jack, the slate 
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor 
connector that supports both audio-out (headphone) and 
audio-in (microphone).

(11) SIM/SD card release access A pinhole for use in ejecting the door covering the SIM and SD 
card slots.

(12) SIM Card slot (select models only) A slot for a SIM card.

NOTE: This feature is available on select models only.

(13) Micro SD memory card reader Reads optional memory cards that store, manage, share, or 
access information.

To insert a card:

Hold the card label-side up, with connectors facing the slot, 
insert the card into the slot, and then push in on the card until 
it is firmly seated.

To remove a card:

Press in on the card it until it pops out.

(14) Power button ● When the slate is off, press the button to turn on 
the slate.

● When the slate is on, press the button briefly to initiate 
Sleep.

● When the slate is in the Sleep state, press the button 
briefly to exit Sleep.

● When the slate is in Hibernation, press the button 
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will 
result in the loss of unsaved information.

If the slate has stopped responding and Windows shutdown 
procedures are ineffective, press and hold the power button 
for at least 15 seconds to turn off the slate.
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Item Component Description

NOTE: For select models, the Intel Rapid Start Technology 
feature is enabled at the factory. Rapid Start Technology 
allows your slate to resume quickly from inactivity.

To learn more about your power settings, see your power 
options. From the Start screen, type power, select Power 
and sleep settings, and then select Power and sleep from 
the list of applications.
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Slate display components

Item Component Description

(1) WLAN antenna* Sends and receives wireless signals to communicate 
with WLANs.

(2) WWAN antennas (2)* Send and receive wireless signals to communicate 
with WWANs.

(3) Webcam light On: The webcam is in use.

(4) Front-facing webcam Records video and captures photographs. Some models 
allow you to video conference and chat online using 
streaming video.

For information on using the webcam, select Start > All 
Programs > Communication and Chat > HP WebCam.

(5) WiGig antenna* Sends and receives wireless signals.

(6) Ambient light sensor Automatically adjusts the display brightness based on 
the lighting conditions in your environment.

(7) Internal microphone Record sound.

(8) Speakers (2) Produce sound.

(9) Windows button Displays the Windows Start menu.

*The antennas are not visible on the outside of the slate. For optimal transmission, keep the areas immediately around the antennas 
free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices that 
applies to your country or region. To access the user guides, select Start > Help and Support > User Guides.
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Keyboard base

Item Component Description

(1) Alignment posts (2) Align and attach the slate to the keyboard.

(2) Docking connector Connects the slate to the keyboard.

CAUTION: To prevent damage to the docking connector, do 
not touch the connector when the slate is detached from 
the keyboard.

(3) Release latch Releases the slate from the keyboard. To release the slate, 
press the release latch.

(4) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a 
password logon.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in combination 
with the fn key.

(2) Function keys Execute frequently used system functions when pressed in 
combination with the fn key.

NOTE: Function keys do not display or function from 
the on-screen slate keyboard.

(3) num lock key Turns the embedded numeric keypad on and off when 
pressed in combination with the fn key.

(4) fn key Executes frequently used system functions when pressed in 
combination with a function key, the num lock key, or 
the esc key.

(5) Windows key Displays the Windows Start menu.

(6) Embedded numeric keypad When num lock has been enabled, it can be used like an 
external numeric keypad.

Each key on the keypad performs the function indicated by 
the icon in the upper-right corner of the key.
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Lights

Item Component Description

(1) Caps lock light On: Caps lock is on, which switches the keys to all 
capital letters.

(2) TouchPad light ● On: The TouchPad is off.

● Off: The TouchPad is on.

(3) Mute light ● Amber: Slate sound is off.

● Off: Slate sound is on.

(4) Microphone mute light ● Amber: microphone sound is off.

● Off: microphone sound is on.

(5) Wireless light On: An integrated wireless device, such as a wireless local 
area network (WLAN) device and/or a Bluetooth device, is on.

NOTE: On some models, the wireless light is amber when 
all wireless devices are off.

(6) Num lock light On: Num lock is on.
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TouchPad

Item Component Description

(1) TouchPad zone Moves the pointer and selects or activates items on 
the screen.

(2) Left TouchPad button Functions like the left button on an external mouse.

(3) Right TouchPad button Functions like the right button on an external mouse.
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Left side

Item Component Description

(1) Volume button Controls speaker volume on the slate.

● To increase speaker volume, press the + edge of 
the button.

● To decrease speaker volume, press the – edge of 
the button.

(2) LCD rotation lock button Locks orientation of the display, preventing 
automatic rotation.

(3) Docking/adapter port Connects the slate to the keyboard, or as a slate only, 
connects an optional adapter.

(4) USB 3.0 port Connects an optional USB device, such as a keyboard, mouse, 
external drive, printer, scanner or USB hub.

(5) Audio-out (headphone)/Audio-in (microphone) jack Connects optional powered stereo speakers, headphones, 
earbuds, a headset, or a television audio cable. Also connects 
an optional headset microphone. This jack does not support 
optional microphone-only devices.

WARNING! To reduce the risk of personal injury, adjust 
the volume before putting on headphones, earbuds, or a 
headset. For additional safety information, see 
the Regulatory, Safety, and Environmental Notices. To access 
the user guides, select Start > Help and Support > 
User Guides.

NOTE: When a device is connected to the jack, the slate 
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor 
connector that supports both audio-out (headphone) and 
audio-in (microphone).

(6) Smart card reader Supports optional Smart cards.
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Right side

Item Component Description

(1) Internal microphone Records sound.

(2) Power button ● When the slate is off, press the button to turn on 
the slate.

● When the slate is on, press the button briefly to initiate 
Sleep.

● When the slate is in the Sleep state, press the button 
briefly to exit Sleep.

● When the slate is in Hibernation, press the button 
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will 
result in the loss of unsaved information.

If the slate has stopped responding and Windows shutdown 
procedures are ineffective, press and hold the power button 
for at least 5 seconds to turn off the slate.

NOTE: For select models, the Intel Rapid Start Technology 
feature is enabled at the factory. Rapid Start Technology 
allows your slate to resume quickly from inactivity.

To learn more about your power settings, see your power 
options. From the Start screen, type power, select Power 
and sleep settings, and then select Power and sleep from 
the list of applications.

(3) Micro SD memory card reader Reads optional memory cards that store, manage, share, or 
access information.

To insert a card:

Hold the card label-side up, with connectors facing the slot, 
insert the card into the slot, and then push in on the card until 
it is firmly seated.

To remove a card:

Press in on the card it until it pops out.

(4) SIM Card slot (select models only) A slot for a SIM card.
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Item Component Description

(5) SIM/SD card release access A pinhole for use in ejecting the door covering the SIM and SD 
card slots.

(6) USB 3.0 charging (powered) port Connects an optional USB device, such as a keyboard, mouse, 
external drive, printer, scanner or USB hub. Standard USB 
ports will not charge all USB devices or will charge using a 
low current. Some USB devices require power and require you 
to use a powered port.

NOTE: USB charging ports can also charge select models of 
cell phones and MP3 players, even when the slate is off.

(7) Dual-Mode DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(8) AC adapter/battery light ● White: The slate is connected to external power and 
the battery is charged from 90 to 99 percent.

● Amber: The slate is connected to external power and 
the battery is charged from 0 to 90 percent.

● Blinking amber: A battery that is the only available 
power source has reached a low battery level. When 
the battery reaches a critical battery level, the battery 
light begins blinking rapidly.

● Off: The battery is fully charged.

(9) Power connector Connects an AC adapter.

*The antennas are not visible on the outside of the slate. For optimal transmission, keep the areas immediately around the antennas 
free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices that 
applies to your country or region. To access the user guides, select Start > Help and Support > User Guides.
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3 Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your slate, go to http://partsurfer.hp.com, select your country or region, and then follow 
the on-screen instructions.

Locating the product name, serial number, product number, 
warranty information, and model name

The product name (1), serial number (2), product number (3), warranty information (4), and model name (5) 
are located on the bottom of the slate. You may need this information when you travel internationally or 
when you contact support.
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Slate major components

Item Component Spare part number

(1) 11.6-in, TouchScreen display panel assembly:

 FHD, BV, (1920×1080), IPS, 50% CG, typical brightness 400 nits, eDP 1.3, ultra-slim 
with digitizer

793736-001

 FHD, BV, (1920×1080), IPS, 50% CG, typical brightness 400 nits, eDP 1.3, ultra-slim 
without digitizer

804352-001

 HD, BV, (1366×768), IPS, 50% CG, typical brightness 400 nits, eDP 1.2, ultra-slim 
with digitizer

793737-001

 HD, BV, (1366×768), IPS, 50% CG, typical brightness 400 nits, eDP 1.2, ultra-slim 
without digitizer

804351-001

 Speaker grille (not illustrated; 2 pieces, includes double-sided adhesive) 793734-001

(2) RTC battery (includes cable and double-sided adhesive) 793723-001
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Item Component Spare part number

(3) Volume button board bracket: Included in the Slate Bracket Kit, spare part number 793728-001.

(4) Heat sink (includes replacement thermal material) 793726-001

(5) Front-facing webcam (includes double-sided adhesive): Included in the Webcam Kit, spare 
part number 793724-001.

NOTE: The front-facing webcam spare part kit does not include the front-facing webcam 
cable. The front-facing webcam cable is included in the Slate Cable Kit, spare part number 
793721-001.

750549-005

(6) Rear-facing webcam: Included in the Webcam Kit, spare part number 793724-001.

NOTE: The rear-facing webcam spare part kit does not include the rear-facing webcam 
cable. The rear-facing webcam cable is included in the Slate Cable Kit, spare part number 
793721-001.

804344-001

(7) Volume button board

NOTE: The volume button board spare part kit does not include the volume button board 
cable. The volume button board cable is included in the Slate Cable Kit, spare part number 
793721-001.

793733-001

(8) Fan (includes cable) 793735-001

(9) WWAN module:

 HP hs3110 HSPA+ Mobile Broadband 748599-005

 HP lt4112 LTE/HSPA+ 4G Mobile Broadband 740011-005

 HP lt4225 LTE/EV-DO Gobi 4G Module 736676-005

 HP lt4226 LTE/HSPA+ Gobi 4G Module 736675-005

(10) WLAN module:

 Intel Tri Band Wireless-AC 17265 802.11a/b/g/n/ac 2×2 and Bluetooth 4.0 + WiGig 
Combo Adapter

806724-005

 Intel Dual Band Wireless-AC 7265 802.11a/b/g/n/ac 2×2 WiFi and Bluetooth 4.0 
Combo Adapter

756749-005

 Intel Dual Band Wireless-AN 7265 802.11a/b/g/n 2×2 and Bluetooth 4.0 Combo Adapter 756748-005

(11) Display panel cable (includes double-sided adhesive) 804344-001

(12) System board (includes a graphics subsystem with UMA memory and replacement thermal material):

 Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, 
and the Windows 8 Professional operating system

805071-601

 Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, 
and the Windows 8 Standard operating system

805071-501

 Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, and a non-
Windows 8 operating system

805071-001

 Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, 
and the Windows 8 Professional operating system

805072-601

 Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, 
and the Windows 8 Standard operating system

805072-501

 Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, and a non-
Windows 8 operating system

805072-001
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Item Component Spare part number

 Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, 
and the Windows 8 Professional operating system

805070-601

 Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, 
and the Windows 8 Standard operating system

805070-501

 Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, and a non-
Windows 8 operating system

805070-001

 Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, 
and the Windows 8 Professional operating system

805069-601

 Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, 
and the Windows 8 Standard operating system

805069-501

 Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, and a non-
Windows 8 operating system

805069-001

 Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, 
and the Windows 8 Professional operating system

805068-601

 Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, 
and the Windows 8 Standard operating system

805068-501

 Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, and a non-
Windows 8 operating system

805068-001

(13) Solid-state drive:

 512-GB, M2, SATA-3 solid-state drive 811391-001

 256-GB, M2, SATA-3 793709-001

 256-GB, M2, SATA-3 solid-state drive supporting TLC 811793-001

 256-GB, M2, SATA-3, SED solid-state drive supporting Opal 2 810987-001

 180-GB, M2, SATA-3 811389-001

 180-GB, M2, SATA-3, SED solid-state drive supporting Opal 2 811390-001

 128-GB, M2, SATA-3 793708-001

 128-GB, M2, SATA-3 solid-state drive supporting TLC 811392-001

(14) Battery, 2-cell, 33-WHr, 4.56-AHr, LI (includes cable) 750549-005

(15) Speakers (includes left and right speakers and cables) 793729-001

(16) Vibrator module (includes left and right vibrator modules and cables) 793730-001

(17) Alignment bracket, left: Included in the Slate Bracket Kit, spare part number 793728-001.

(18) Docking connector bracket: Included in the Slate Bracket Kit, spare part number 793728-001.

(19) Alignment bracket, right: Included in the Slate Bracket Kit, spare part number 793728-001.

 Antenna Kit, includes:

(20) WiGig antenna cable and transceiver (for use only on slate models equipped with 
WiGig capability)

805066-001

(21) WWAN main and auxiliary cables and transceivers

(22) WLAN antenna cable and transceiver

 For use in African, European, and Middle Eastern countries and regions 805065-001
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Item Component Spare part number

 For use in Japan 806251-001

 For use in North America 805067-001

(23) Docking connector board

NOTE: The docking connector board spare part kit does not include the docking connector 
board cable. The docking connector board cable is included in the Slate Cable Kit, spare part 
number 793721-001.

793731-001

(24) Audio jack board (includes cable) 793732-001

(25) Docking connector board cable: Included in the Slate Cable Kit, spare part number 793721-001.

(26) Back cover 793725-001
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Keyboard base

Item Description Spare part number

(1) Keyboard (includes keyboard cable and keyboard backlight cable):

 For use in Belgium 793738-A41

 For use in Brazil 793738-201

 For use in Bulgaria 793738-261

 For use in Canada 793738-DB1

 For use in the Czech Republic and Slovakia 793738-FL1

 For use in Denmark 793738-081

 For use in France 793738-051

 For use in Germany 793738-041

Keyboard base 21



Item Description Spare part number

 For use in Greece 793738-151

 For use in Hungary 793738-211

 For use in Iceland 793738-DD1

 For use in India 793738-D61

 For use in Israel 793738-BB1

 For use in Italy 793738-061

 For use in Japan 793738-291

 For use in Latin America 793738-161

 For use in the Netherlands 793738-B31

 For use in North Africa 793738-FP1

 For use in Portugal 793738-131

 For use in Romania 793738-271

 For use in Russia 793738-251

 For use in Saudi Arabia 793738-171

 For use in Slovenia 793738-BA1

 For use in South Korea 793738-AD1

 For use in Spain 793738-071

 For use in Sweden and Finland 793738-B71

 For use in Switzerland 793738-111

 For use in Taiwan 793738-AB1

 For use in Thailand 793738-281

 For use in Turkey 793738-141

 For use in the United Kingdom and Singapore 793738-031

 For use in the United States 793738-001

(2) Top cover 793718-001

(3) TouchPad (includes cable) 793720-001

(4) Fingerprint reader board

NOTE: The fingerprint reader board spare part kit does not include the fingerprint reader 
board cable. The fingerprint reader board cable is included in the Keyboard Base Cable Kit, 
spare part number 793721-001.

793713-001

(5) Connector board (includes USB port and DisplayPort)

NOTE: The connector board spare part kit does not include the connector board cable. 
The connector board cable is included in the Keyboard Base Cable Kit, spare part number 
793721-001.

804350-001

(6) Smart card reader board 793711-001

22 Chapter 3   Illustrated parts catalog



Item Description Spare part number

NOTE: The smart card reader board spare part kit does not include the smart card reader 
board cable. The smart card reader board cable is included in the Keyboard Base Cable Kit, 
spare part number 793721-001.

(7) Battery, 6-cell, 21-WHr, 0.95-AHr, LI (includes cable) 750550-005

(8) Power connector cable 793714-001

(9) Keyboard base system board (includes docking/adapter port, USB port, and audio jack) 806252-001

(10) Hinge assembly (includes left and right cables) 793717-001

(11) Kickstand (includes rubber feet) 793715-001

 Kickstand Hinge Kit (not illustrated) 793716-001

(12) Bottom cover 793710-001

 Rubber Kit (not illustrated, includes bottom cover rubber feet) 804348-001

Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart adapter (non-PFC, 3-wire) 693716-001

45-W HP Smart adapter (non-PFC, RC, 3-wire) 742436-001

Bracket Kit:

For use on the keyboard base, includes:

● Connector board cable

● Fingerprint reader board cable

● Smart card reader board cable

793712-001

For use on the slate, includes:

● Alignment guide left bracket

● Alignment guide right bracket

● Docking connector board bracket

● Volume button board bracket

793728-001

Cable Kit:

For use on the keyboard base, includes:

● Connector board cable

● Fingerprint reader board cable

● Smart card reader board cable

793719-001

For use on the slate, includes:

● Digitizer board cable

● Docking connector board cable

793721-001
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Component Spare part number

● Front-facing webcam cable

● Rear-facing webcam cable

● TouchScreen cable

● Volume button board cable

Digitizer pen 804346-001

Travel keyboard:

For use in Belgium 800577-A41

For use in Brazil 800577-201

For use in Bulgaria 800577-261

For use in the Czech Republic and Slovakia 800577-FL1

For use in Denmark 800577-081

For use in France 800577-051

For use in Germany 800577-041

For use in Greece 800577-151

For use in Hungary 800577-211

For use in Iceland 800577-DD1

For use in India 800577-D61

For use in Israel 800577-BB1

For use in Italy 800577-061

For use in Japan 800577-291

For use in Latin America 800577-161

For use in the Netherlands 800577-B31

For use in North Africa 800577-FP1

For use in Norway 800577-091

For use in Portugal 800577-131

For use in Romania 800577-271

For use in Russia 800577-251

For use in Saudi Arabia 800577-171

For use in Slovenia 800577-BA1

For use in South Korea 800577-AD1

For use in Spain 800577-071

For use in Sweden and Finland 800577-B71

For use in Switzerland 800577-111

For use in Taiwan 800577-AB1
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Component Spare part number

For use in Thailand 800577-281

For use in Turkey 800577-141

For use in the United Kingdom and Singapore 800577-031

For use in the United States 800577-001

Plastics Kit for use on the slate, includes:

● Power button actuator

● Rotate lock button actuator

● SD card/SIM cover

● Volume button actuator

804347-001

Power cord, 3-pin, black, 1.83-m:

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Power cord, 3-pin, black, 1.83-m:

For use in Argentina 755530-D01

For use in Australia 755530-011

For use in Brazil 755530-202

For use in Denmark 755530-081

For use in Europe 755530-021

For use in India 755530-D61
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Component Spare part number

For use in Israel 755530-BB1

For use in Italy 755530-061

For use in Japan 755530-291

For use in North America 755530-001

For use in the People's Republic of China 755530-AA1

For use in South Africa 755530-AR1

For use in South Korea 755530-AD1

For use in Switzerland 755530-111

For use in Taiwan 755530-AB1

For use in Thailand 755530-201

For use in the United Kingdom and Singapore 755530-031

Power cord, 2-pin, black, 1.00-m, for use in Japan 762689-291

Screw Kit:

For use on the keyboard base 804349-001

For use on the slate 793727-001
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4 Removal and replacement preliminary 
requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 screw driver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly 
and assembly procedures.

NOTE: As you remove each subassembly from the slate, place the subassembly (and all accompanying 
screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care 
when handling the plastic parts. Apply pressure only at the points designated in the 
maintenance instructions.

Cables and connectors

CAUTION: When servicing the slate, be sure that cables are placed in their proper locations during the 
reassembly process. Improper cable placement can damage the slate.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or 
seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, 
avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be 
caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables 
tear easily.

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure 
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection, 
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
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An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal 
cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life 
expectancy.

CAUTION: To prevent damage to the slate when you are removing or installing internal components, 
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described in this 
section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by 
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized 
equipment used for moving materials is wired to ground and that proper materials are selected to avoid 
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and 
equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids 
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap 
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips 
to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be 
used at standing workstations and are compatible with most types of shoes or boots. On conductive 
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance 
between the operator and ground. To be effective, the conductive must be worn in contact with the 
skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive slateop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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5 Removal and replacement procedures – 
slate

NOTE: This chapter provides removal and replacement procedures for Authorized Service Provider only 
components. Components described in this chapter should only be accessed by an authorized service 
provider. Accessing these components can damage the slate or void the warranty.

There are as many as 45 screws that must be removed, replaced, and/or loosened when servicing the slate. 
Make special note of each screw size and location during removal and replacement.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your slate, go to http://partsurfer.hp.com, select your country or region, and then follow 
the on-screen instructions.

Unlocking the device and disabling Always On Remote 
Management (select HP devices only)

HP Touchpoint Manager (HPTM) is a complete cloud-based solution for managing devices. For select HP 
devices with the Windows operating system, the Always On Remote Management (AORM) feature is 
automatically activated when HP Touchpoint Manager software is installed.

AORM can perform a secure BIOS level lock and can also securely erase internal drives (except for encrypted 
self-encrypting drives). The HP Touchpoint Manager website (http://www.hptouchpointmanager.com) 
provides access to the AORM lock feature. The device must be unlocked using an authorized PIN from 
the same website before you can access HP Slate Setup and start the Windows operating system.

IMPORTANT: A service agent cannot retrieve the PIN from the HP Touchpoint Manager website. If a locked 
device is returned for service, the agent must contact the customer to obtain the PIN to unlock the device. If a 
PIN is not available, the entire system board must be replaced.

Before returning the device for service, be sure to unlock the device using the PIN from the HP Touchpoint 
Manager website (http://www.hptouchpointmanager.com), and also disable the  AORM feature in HP Slate 
Setup.

To disable AORM:

1. Access HP Slate Setup (F10).

a. Turn on or restart the device, and then press esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen.

b. Press f10 to enter Slate Setup.

NOTE: If the BIOS is protected with an Administrator password, enter the password.

2. Select Advanced, and then select HP Touchpoint Manager Options.

3. Clear the Allow Activation check box.

4. Select Save changes and exit.
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Display panel assembly

Description Spare part number

11.6-in, TouchScreen, FHD, BV, (1920×1080), IPS, 50% CG, typical brightness 400 nits, eDP 1.3, ultra-
slim with digitizer display panel assembly

793736-001

11.6-in, TouchScreen, FHD, BV, (1920×1080), IPS, 50% CG, typical brightness 400 nits, eDP 1.3, ultra-
slim without digitizer display panel assembly

804352-001

11.6-in, TouchScreen, HD, BV, (1366×768), IPS, 50% CG, typical brightness 400 nits, eDP 1.2, ultra-slim 
with digitizer display panel assembly

793737-001

11.6-in, TouchScreen, HD, BV, (1366×768), IPS, 50% CG, typical brightness 400 nits, eDP 1.2, ultra-slim 
without digitizer display panel assembly

804351-001

Back cover 793725-001

Before removing the disassembling the slate, follow these steps:

1. Turn off the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and then 
shut it down through the operating system.

2. Disconnect the power from the slate by unplugging the power cord from the slate.

3. Disconnect all external devices from the slate.

Remove the display panel assembly:

1. Place the slate on a flat work surface with the docking connector toward you.

2. Remove the speaker grille (1) that covers the display panel screws.

The speaker grille is available using spare part number 793734-001.

3. Remove the six Phillips PM1.5×8.3 screws (2) and the three Phillips PM1.5×3.5 screws (3) that secure 
the display panel assembly to the bottom cover.

CAUTION: Do not completely separate the display panel assembly from the bottom cover in the next 
step. There are 2 ribbon cables connecting the display panel assembly to the system board that can be 
damaged if too much separation is achieved.
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4. Lift the bottom edge (4) of the display panel assembly until it separates from the bottom cover.

5. Release the zero insertion force (ZIF) connector (1) to which the TouchScreen board cable is attached, 
and then disconnect the TouchScreen board cable from the system board.

6. Release the adhesive strip (2) that secures the display panel cable connector to the system board.

7. Disconnect the display panel cable (3) from the system board.

8. Release the ZIF connector (4) to which the digitizer board cable is attached, and then disconnect 
the digitizer board cable from the system board.
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9. Remove the display panel assembly (5).

CAUTION: Before turning the display panel upside down, make sure the work surface is clear of tools, 
screws, and any other foreign objects. Failure to follow this caution can result in damage to 
the display panel assembly.

10. If it is necessary to replace the display panel cable:

a. Turn the display panel assembly upside down with the docking connector toward you.

b. Release the adhesive strip (1) that secures the display panel cable connector to 
the display panel assembly.

c. Disconnect the display panel cable (2) from the display panel.
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d. Remove the display panel cable (3).

The display panel cable is available using spare part number 804344-001.

Reverse this procedure to reassemble and install the display panel assembly.
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Battery

Description Spare part number

Battery, 2-cell, 33-WHr, 4.56-AHr, Li-ion (includes cable) 750549-005

Before removing the battery, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

WARNING! To reduce potential safety issues, use only the battery provided with the slate, a replacement 
battery provided by HP, or a compatible battery purchased from HP.

CAUTION: Removing a battery that is the sole power source for the slate can cause loss of information. 
To prevent loss of information, save your work or shut down the slate through Windows before removing 
the battery.

Remove the battery:

1. Disconnect the battery cable (1) from the system board.

2. Remove the six PM1.6×2.5 screws (2) that secure the battery to the bottom cover.

3. Remove the battery (3).
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Reverse this procedure to install the battery.

WLAN module

Description Spare part number

Intel Tri Band Wireless-AC 17265 802.11a/b/g/n/ac 2×2 and Bluetooth 4.0 + WiGig Combo Adapter 806724-005

Intel Dual Band Wireless-AC 7265 802.11a/b/g/n/ac 2×2 WiFi and Bluetooth 4.0 Combo Adapter 756749-005

Intel Dual Band Wireless-AN 7265 802.11a/b/g/n 2×2 and Bluetooth 4.0 Combo Adapter 756748-005

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module 
authorized for use in the slate by the governmental agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a warning message, remove the module to restore device 
functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Disconnect the battery cable from the system board (see Battery on page 36).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1/Main” connects to the WLAN module “1/Main” terminal. 
The WLAN antenna cable labeled “2/Aux” connects to the WLAN module “2/Aux” terminal.

2. Remove the Phillips PM1.9×3.4 screw (2) that secures the WLAN module to the bottom cover. (The 
WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the WLAN module terminals, protective sleeves 
should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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WWAN module

Description Spare part number

HP hs3110 HSPA+ Mobile Broadband 748599-005

HP lt4112 LTE/HSPA+ 4G Mobile Broadband 740011-005

HP lt4225 LTE/EV-DO Gobi 4G Module 736676-005

HP lt4226 LTE/HSPA+ Gobi 4G Module 736675-005

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module 
authorized for use in the slate by the governmental agency that regulates wireless devices in your country or 
region. If you replace the module and then receive a warning message, remove the module to restore device 
functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Disconnect the battery cable from the system board (see Battery on page 36).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The WWAN antenna cable labeled “5/Main” connects to the WWAN module “5/Main” terminal. 
The WWAN antenna cable labeled “6/Aux” connects to the WWAN module “6/Aux” terminal.

2. Remove the Phillips PM1.9×3.4 screw (2) that secures the WWAN module to the bottom cover. (The 
WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the WWAN module terminals, protective sleeves 
should be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Speakers

Description Spare part number

Speakers (include left and right speakers and cables) 793729-001

Before removing the speakers, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

Remove the speakers:

1. Disconnect the speaker cable (1) from the docking connector board.

2. Remove the four Phillips PM1.6×2.5 screws (2) that secure the speakers to the bottom cover.

3. Release the speakers cables from the retention tabs (3) built into the bottom cover.

4. Remove the speakers (4).

Reverse this procedure to install the speakers.
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Vibrator module

Description Spare part number

Vibrator module (includes left and right vibrator modules and cables) 793730-001

Before removing the vibrator module, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

Remove the vibrator module:

1. Disconnect the vibrator module cable (1) from the docking connector board.

2. Release the vibrator module cables from the retention tabs (2) built into the bottom cover.

3. Detach the vibrator module (3) from the bottom cover. (The vibrator module is attached to the bottom 
cover with double-sided adhesive.)

4. Remove the vibrator module.

Reverse this procedure to install the vibrator module.
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Fan

Description Spare part number

Fan (includes cable) 793735-001

NOTE: To properly ventilate the slate, allow at least 7.6 cm (3 in) of clearance on the left side of the slate. 
The slate uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, 
battery fast charging, and software requirements. Exhaust air is displaced through the ventilation grill 
located on the left side of the slate.

Before removing the fan, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Remove the three Phillips PM1.9×3.4 screws (2) that secure the fan to the bottom cover.
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3. Remove the fan (3).

Reverse this procedure to install the fan.

Volume button board

Description Spare part number

Volume button board

NOTE: The volume button board spare part kit does not include the volume button board cable. The 
volume button board cable is included in the Slate Cable Kit, spare part number 793721-001.

793733-001

Before removing the volume button board, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

Remove the volume button board:
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1. Release the ZIF connector (1) to which the volume button board cable is attached, and then disconnect 
the volume button board cable from the system board.

2. Remove the three Phillips PM1.5×2.3 screws (2) that secure the volume button board to 
the bottom cover.

3. Remove the bracket (3) that secures the volume button board to the bottom cover.

The volume button board bracket is included in the Slate Bracket Kit, spare part number 793712-001.

4. Remove the volume button board (4) and cable.

Reverse this procedure to install the volume button board.
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Docking connector board

Description Spare part number

Docking connector board

NOTE: The docking connector board spare part kit does not include the docking connector 
board cable. The docking connector board cable is included in the Slate Cable Kit, spare part number 
793721-001.

793731-001

Before removing the docking connector board, follow these steps:

1. Turn off the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and then 
shut it down through the operating system.

2. Disconnect the power from the slate by unplugging the power cord from the slate.

3. Disconnect all external devices from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

Remove the docking connector board:

1. Remove the following screws:

(1) Four Phillips PM1.9×2.5 screws

(2) One Phillips PM1.5×2.3 screw

(3) One Phillips PM1.5×3.5 screw

2. Remove the left alignment post connector bracket (4).

3. Remove the docking connector board bracket (5).

46 Chapter 5   Removal and replacement procedures – slate



4. Remove the right alignment post connector bracket (6).

The alignment post connector brackets and the docking connector board bracket are included in 
the Table Bracket Kit, spare part number 793712-001.

5. Release the docking connector board (1) and audio jack board by sliding them back until they clear 
the bottom edge of the bottom cover.

6. Flip the docking connector board (2) and audio jack board upside down.
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7. Release the ZIF connector (3) to which the docking connector board cable is attached, and then 
disconnect the docking connector board cable from the docking connector board.

8. Remove the docking connector board, audio jack board, and audio jack board cable.

Reverse this procedure to install the docking connector board.

Audio jack board

Description Spare part number

Audio jack board (includes cable) 793732-001

Before removing the audio jack board, follow these steps:

1. Turn off the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and then 
shut it down through the operating system.

2. Disconnect the power from the slate by unplugging the power cord from the slate.

3. Disconnect all external devices from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32).

5. Remove the battery (see Battery on page 36).

6. Remove the docking connector board (see Docking connector board on page 46).

Remove the audio jack board:

1. Release the ZIF connector (1) to which the audio jack board cable is attached, and then disconnect 
the audio jack board cable from the docking connector board.
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2. Remove the audio jack board (2) and cable.

Reverse this procedure to install the audio jack board and cable.

System board

Description Spare part number

Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, and the Windows 8 
Professional operating system

805071-601

Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, and the Windows 8 
Standard operating system

805071-501

Equipped with an Intel Core i7 M-5Y71 processor, 8.0-GB of system memory, and a non-Windows 8 
operating system

805071-001

Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, and the Windows 8 
Professional operating system

805072-601

Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, and the Windows 8 
Standard operating system

805072-501

Equipped with an Intel Core i7 M-5Y71 processor, 4.0-GB of system memory, and a non-Windows 8 
operating system

805072-001

Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, and the Windows 8 
Professional operating system

805070-601

Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, and the Windows 8 
Standard operating system

805070-501

Equipped with an Intel Core i5 M-5Y51 processor, 8.0-GB of system memory, and a non-Windows 8 
operating system

805070-001

Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, and the Windows 8 
Professional operating system

805069-601

Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, and the Windows 8 
Standard operating system

805069-501

Equipped with an Intel Core i5 M-5Y51 processor, 4.0-GB of system memory, and a non-Windows 8 
operating system

805069-001
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Description Spare part number

Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, and the Windows 8 
Professional operating system

805068-601

Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, and the Windows 8 
Standard operating system

805068-501

Equipped with an Intel Core i3 M-5Y10c processor, 4.0-GB of system memory, and a non-Windows 8 
operating system

805068-001

Before removing the system board, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

When replacing the system board, be sure that the following components are removed from the defective 
system board and installed on the replacement system board:

● RTC battery (see RTC battery on page 56)

● Solid-state drive (see Solid-state drive on page 57)

● Heat sink (see Heat sink on page 59)

● Rear-facing webcam (see Rear-facing webcam on page 61)

● Front-facing webcam (see Front-facing webcam on page 62)

Remove the system board:

1. Detach the WLAN antenna transceiver (1) from the bottom cover. (The WLAN antenna transceiver is 
attached to the bottom cover with double-sided adhesive.)

2. Remove the Phillips PM1.5×2.3 screw (2) that secures the front-facing webcam to the bottom cover.

3. Release the front-facing webcam (3) from the bottom cover.
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4. Detach the rear-facing webcam (4) from the bottom cover. (The rear-facing webcam is attached to 
the bottom cover with double-sided adhesive.)

5. Release the ZIF connector (1) to which the volume button board cable is attached, and then disconnect 
the volume button board cable from the volume button board.

6. Detach the RTC battery (2) from the bottom cover. (The RTC battery is attached to the bottom cover 
with double-sided adhesive.)

7. Release the RTC battery cable from the retention clips (3) built into the bottom cover.
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8. Release the adhesive strip (4) that secures the docking connector board cable to the system board.
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9. Remove the six Phillips PM1.5×2.3 screws that secure the system board to the bottom cover.

10. Flip the system board (1) up and forward so that it rests upside down in the bottom cover.

11. Release the ZIF connector (2) to which the docking connector board cable is attached, and then 
disconnect the docking connector board cable from the system board.

12. Remove the system board (3).

NOTE: When removing the system board, it is possible for the power button actuator to accidentally fall out 
of the bottom cover. To install the power button actuator, follow the ensuing procedure:

1. Toe the power button actuator into the bottom cover, making sure the tabs fit under the ridge built into 
the right side of the bottom cover.
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2. When the system board has been installed, make sure the power switch (1) engages with the notch (2) 
built into the power button actuator.

Reverse this procedure to install the system board.
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Volume button board cable
NOTE: The volume button board cable is included in the Slate Cable Kit, spare part number 793721-001.

Before removing the volume button board cable, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the volume button board cable:

1. Turn the system board upside down with the docking connector toward you.

2. Release the ZIF connector (1) to which the volume button board cable is attached, and then disconnect 
the volume button board cable from the system board.

3. Remove the volume button board cable (2).

Reverse this procedure to install the volume button board cable.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 793723-001

Before removing the RTC battery, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the RTC battery:

1. Turn the system board upside down with the docking connector toward you.

2. Disconnect the RTC battery cable (1) from the system board.

3. Remove RTC battery (2).
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Reverse this procedure to install the RTC battery.

Solid-state drive

Description Spare part number

512-GB, M2, SATA-3 solid-state drive 811391-001

256-GB, M2, SATA-3 793709-001

256-GB, M2, SATA-3 solid-state drive supporting TLC 811793-001

256-GB, M2, SATA-3, SED solid-state drive supporting Opal 2 810987-001

180-GB, M2, SATA-3 811389-001

180-GB, M2, SATA-3, SED solid-state drive supporting Opal 2 811390-001

128-GB, M2, SATA-3 793708-001

128-GB, M2, SATA-3 solid-state drive supporting TLC 811392-001

Before removing the solid-state drive, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the solid-state drive:

1. Turn the system board upside down with the docking connector toward you.

2. Remove the Phillips PM1.3×1.9 screw that secures the solid-state drive to the system board. (The solid-
state drive tilts up.)
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3. Remove solid-state drive (2).

Reverse this procedure to install the solid-state drive.
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Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 793726-001

Before removing the heat sink, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the heat sink:

1. Turn the system board upside down with the docking connector toward you.

2. Remove the four Phillips PM1.9×3.4 screws (1) that secure the heat sink to the system board.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and system 
board components, it may be necessary to move the heat sink from side to side to detach it.
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3. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system 
board each time the heat sink is removed. Thermal paste is used on the processor (1) and the heat sink 
section (2) that services it.

Reverse this procedure to install the heat sink.
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Rear-facing webcam
NOTE: The rear-facing webcam is included in the Webcam Kit, spare part number 793724-001.

The rear-facing webcam spare part kit does not include the rear-facing webcam cable. The rear-facing 
webcam cable is included in the Slate Cable Kit, spare part number 793721-001.

Before removing the rear-facing webcam, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the rear-facing webcam:

1. Turn the system board upside down with the top edge toward you.

2. Disconnect the rear-facing webcam cable (1) from the front-facing webcam board.

3. Remove the rear-facing webcam (2).

Reverse this procedure to install the rear-facing webcam.
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Front-facing webcam
NOTE: The front-facing webcam is included in the Webcam Kit, spare part number 793724-001, and 
includes double-sided adhesive.

The front-facing webcam spare part kit does not include the front-facing webcam cable. The front-facing 
webcam cable is included in the Slate Cable Kit, spare part number 793721-001.

Before removing the front-facing webcam, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

f. Rear-facing webcam (see Rear-facing webcam on page 61)

Remove the front-facing webcam:

1. Release the ZIF connector (1) to which the front-facing webcam board cable is attached, and then 
disconnect the front-facing webcam board cable from the system board.

2. Detach the front-facing webcam board cable (2) from the system board. (The front-facing webcam 
board cable is attached to the system board with double-sided adhesive.)
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3. Remove the front-facing webcam (3) and cable.

Reverse this procedure to install the front-facing webcam.
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WWAN antenna
NOTE: The WWAN auxiliary and main antennas are included in the Antenna Kit, using the following spare 
part numbers:

● 805065-001 – For use in African, European, and Middle Eastern countries and regions

● 806251-001 – For use in Japan

● 805067-001 – For use in North America

Before removing the WWAN antenna, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the WWAN antenna:

1. Detach the WWAN main antenna transceiver (1) from the bottom cover. (The WWAN main antenna 
transceiver is attached to the bottom cover with double-sided adhesive.)
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2. Release the WWAN main antenna (2) transceiver and cable.

3. Detach the WWAN auxiliary antenna transceiver (1) from the bottom cover. (The WWAN auxiliary 
antenna transceiver is attached to the bottom cover with double-sided adhesive.)

4. Release the WWAN auxiliary antenna cable from the retention tabs (2) built into the bottom cover.
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5. Release the WWAN auxiliary antenna (3) transceiver and cable.

Reverse this procedure to install the WWAN antenna.
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WLAN antenna
NOTE: The WLAN main antenna is included in the Antenna Kit, using the following spare part numbers:

● 805065-001 – For use in African, European, and Middle Eastern countries and regions

● 806251-001 – For use in Japan

● 805067-001 – For use in North America

Before removing the WLAN antenna, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the WLAN antenna:

1. Release the WLAN antenna cable from the retention tabs (1) built into the bottom cover.

2. Remove the WLAN antenna (2) transceiver and cable.
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Reverse this procedure to install the WLAN antenna.

WiGig antenna

Description Spare part number

WiGig antenna (includes WiGig antenna cable and transceiver) 805066-001

Before removing the WiGig antenna, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. System board (see System board on page 49)

Remove the WiGig antenna:

1. Detach the WiGig antenna transceiver (1) from the bottom cover. (The WiGig antenna transceiver is 
attached to the bottom cover with double-sided adhesive.)

2. Release the WiGig antenna cable from the retention tabs (2) built into the bottom cover.
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3. Remove the WiGig antenna (3) cable and transceiver.

Reverse this procedure to install the WiGig antenna.

Docking connector board cable
NOTE: The docking connector board cable is included in the Slate Cable Kit, spare part number 793721-001.

Before removing the docking connector board cable, follow these steps:

1. Shut down the slate. If you are unsure whether the slate is off or in Hibernation, turn the slate on, and 
then shut it down through the operating system.

2. Disconnect all external devices connected to the slate.

3. Disconnect the power from the slate by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the slate.

4. Remove the display panel assembly (see Display panel assembly on page 32), and then remove 
the following components:

a. Battery (see Battery on page 36)

b. WLAN module (see WLAN module on page 37)

c. WWAN module (see WWAN module on page 39)

d. Fan (see Fan on page 43)

e. Docking connector board (see Docking connector board on page 46)

f. System board (see System board on page 49)

Remove the docking connector board cable:

1. Detach the docking connector board cable (1) from the bottom cover. (The docking connector 
board cable is attached to the bottom cover with double-sided adhesive.)
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2. Remove the docking connector board cable (2).

Reverse this procedure to install the docking connector board cable.
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6 Removal and replacement procedures – 
Keyboard base

NOTE: This chapter provides removal and replacement procedures for Authorized Service Provider only 
components. Components described in this chapter should only be accessed by an authorized service 
provider. Accessing these components can damage the keyboard base or void the warranty.

There are as many as 49 screws that must be removed, replaced, and/or loosened when servicing 
the keyboard base. Make special note of each screw size and location during removal and replacement.

NOTE: HP continually improves and changes product parts. For complete and current information on 
supported parts for your keyboard base, go to http://partsurfer.hp.com, select your country or region, and 
then follow the on-screen instructions.

Bottom cover

Description Spare part number

Bottom cover 793710-001

Rubber Kit (includes bottom cover rubber feet) 804348-001

Before disassembling the keyboard base, follow these steps:

1. Turn off the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect the power from the keyboard base by unplugging the power cord from the keyboard base.

3. Disconnect all external devices from the keyboard base.

Remove the bottom cover:

1. Turn the keyboard base upside down on a flat work surface with the front edge toward you.

2. Remove the eleven Torx8 T8M2.0×4.3 screws (1) secure the bottom cover to the keyboard base.
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3. Remove the bottom cover (2).

Reverse this procedure to install the bottom cover.

Keyboard base battery

Description Spare part number

Battery, 6-cell, 21-WHr, 0.95-AHr, LI (includes cable) 750550-005

Before removing the keyboard base battery, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

Remove the keyboard base battery:

1. Disconnect the keyboard base battery cable (1) from the keyboard base system board.

2. Remove the nine PM2.0×3.6 screws (2) that secure the keyboard base battery to the keyboard base.
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3. Remove the keyboard base battery (3).

Reverse this procedure to install the keyboard base battery.

Power connector cable

Description Spare part number

Power connector cable 793714-001

Before removing the power connector cable, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Disconnect the keyboard base battery cable from the keyboard base system board (see Keyboard base 
battery on page 72).

Remove the power connector cable:
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1. Disconnect the power connector cable (1) from the keyboard base system board.

2. Remove the two Phillips PM2.0×3.6 screws (2) that secure the power connector cable bracket to 
the top cover.

3. Remove the power connector cable bracket (3).

The power connector cable bracket is included in the Keyboard Base Bracket Kit, spare part number 
793728-001.

4. Remove the Phillips PM1.5×2.7 screw (4) that secures the power connector to the top cover.

5. Remove the power connector cable (5).

Reverse this procedure to install the power connector cable.

Keyboard

For use in country or region: Spare part number: For use in country or region: Spare part number:

Keyboard (includes keyboard cable and keyboard backlight cable):

For use in Belgium 793738-A41 For use in the Netherlands 793738-B31

For use in Brazil 793738-201 For use in North Africa 793738-FP1

For use in Bulgaria 793738-261 For use in Portugal 793738-131

For use in Canada 793738-DB1 For use in Romania 793738-271

For use in the Czech Republic 
and Slovakia

793738-FL1 For use in Russia 793738-251

For use in Denmark 793738-081 For use in Saudi Arabia 793738-171
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For use in country or region: Spare part number: For use in country or region: Spare part number:

For use in France 793738-051 For use in Slovenia 793738-BA1

For use in Germany 793738-041 For use in South Korea 793738-AD1

For use in Greece 793738-151 For use in Spain 793738-071

For use in Hungary 793738-211 For use in Sweden and Finland 793738-B71

For use in Iceland 793738-DD1 For use in Switzerland 793738-111

For use in India 793738-D61 For use in Taiwan 793738-AB1

For use in Israel 793738-BB1 For use in Thailand 793738-281

For use in Italy 793738-061 For use in Turkey 793738-141

For use in Japan 793738-291 For use in the United Kingdom 
and Singapore

793738-031

For use in Latin America 793738-161 For use in the United States 793738-001

Before removing the keyboard, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

Remove the keyboard:

1. Disconnect the keyboard backlight cable from the low insertion force (LIF) connector (1) on keyboard 
base system board.

2. Release the ZIF connector (2) to which the keyboard cable is attached, and then disconnect 
the keyboard cable from the keyboard base system board.

3. Release the six retention tabs (3) that secure the keyboard to the top cover.
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4. Insert a case utility tool (4) or similar thin, plastic tool into the keyboard release hole and press on 
the back of the keyboard.

NOTE: When releasing the keyboard, make sure the keyboard backlight cable (5) and the keyboard 
cable (6) route cleanly through the openings in the top cover.

5. Turn the keyboard base right side up with the front edge toward you.

6. Lift the rear edge of the keyboard (1) until it rests at an angle.

7. Slide the keyboard (2) up and back at an angle until the tabs on the front edge disengage from the slots 
built into the top cover.

8. Remove the keyboard (3).

Reverse this procedure to install the keyboard.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board

NOTE: The fingerprint reader board spare part kit does not include the fingerprint reader board cable. 
The fingerprint reader board cable is included in the Keyboard Base Cable Kit, spare part number 
793721-001.

793713-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

Remove the fingerprint reader board:

1. Disconnect the fingerprint reader board cable from the LIF connector (1) on fingerprint reader board.

2. Remove the Phillips PM1.5×2.7 screw (2) that secures the fingerprint reader board and bracket to 
the top cover.

3. Remove the fingerprint reader board bracket (3).

The fingerprint reader board bracket is included in the Keyboard Base Bracket Kit, spare part number 
793728-001.
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4. Remove the fingerprint reader board (4).

Reverse this procedure to install the fingerprint reader board.

TouchPad

Description Spare part number

TouchPad (includes cable) 793720-001

Before removing the TouchPad, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

Remove the TouchPad:

1. Disconnect the TouchPad cable from the LIF connector (1) on smart card reader board.

2. Remove the four Phillips PM1.5×2.7 screws (2) that secure the TouchPad to the top cover.
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3. Remove the TouchPad (3).

Reverse this procedure to install the TouchPad.

Smart card reader board

Description Spare part number

Smart card reader board

NOTE: The smart card reader board spare part kit does not include the smart card reader board cable. 
The smart card reader board cable is included in the Keyboard Base Cable Kit, spare part number 
793721-001.

793711-001

Before removing the smart card reader board, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the battery (see Keyboard base battery on page 72).

Remove the smart card reader board:

1. Disconnect the TouchPad cable from the LIF connector (1) on smart card reader board.

2. Release the ZIF connector (2) to which the smart card reader board cable is attached, and then 
disconnect the smart card reader board cable from the keyboard base connector board.
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3. Remove the five Phillips PM1.5×2.7 screws (3) that secure the smart card reader board to the top cover.

4. Remove the smart card reader board (4).

Reverse this procedure to install the smart card reader board.

Connector board

Description Spare part number

Connector board (includes USB port and DisplayPort)

NOTE: The connector board spare part kit does not include the connector board cable. The 
connector board cable is included in the Keyboard Base Cable Kit, spare part number 793721-001.

804350-001

Before removing the connector board, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

Remove the connector board:
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1. Release the ZIF connector (1) to which the smart card reader board cable is attached, and then 
disconnect the smart card reader board cable from the keyboard base connector board.

2. Release the ZIF connector (2) to which the connector board cable is attached, and then disconnect 
the connector board cable from the keyboard base system board.

3. Remove the two Phillips PM2.0×3.6 screws (3) that secure the connector board and bracket to 
the top cover.

4. Remove the connector board bracket (4).

The connector board bracket is included in the Keyboard Base Bracket Kit, spare part number 
793728-001.

5. Remove the connector board (5) and cable.

Reverse this procedure to install the connector board.

Keyboard base system board

Description Spare part number

Keyboard base system board (includes docking/adapter port, USB port, and audio jack) 806252-001

Before removing the keyboard base system board, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.
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4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

Remove the keyboard base system board:

1. Disconnect the fingerprint reader board cable from the LIF connector (1) on fingerprint reader board.

2. Detach the fingerprint reader board cable (2) from the top cover. (The fingerprint reader board cable is 
attached to the top cover with double-sided adhesive.)

3. Release the adhesive strip (3) that secures the hinge assembly right cable to the keyboard base 
system board.

4. Disconnect the hinge assembly right cable (4) from the keyboard base system board.

5. Disconnect the power connector cable (5) from the keyboard base system board.

6. Disconnect the keyboard backlight cable from the LIF connector (1) on the keyboard base system board.

7. Release the ZIF connector (2) to which the keyboard cable is attached, and then disconnect 
the keyboard cable from the keyboard base system board.

8. Release the adhesive strip (3) that secures the hinge assembly left cable to the keyboard base 
system board.

9. Disconnect the hinge assembly left cable (4) from the keyboard base system board.
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10. Release the ZIF connector (5) to which the connector board cable is attached, and then disconnect 
the connector board cable from the keyboard base system board.

11. Remove the two Phillips PM2.0×2.5 broad head screws (1) that secure the keyboard base system board 
to the top cover.

12. Remove the two Phillips PM2.0×3.6 screws (2) that secure the power connector cable bracket to 
the top cover.

13. Remove the power connector cable bracket (3).

The power connector cable bracket is included in the Keyboard Base Bracket Kit, spare part number 
793728-001.

14. Lift the right side of the keyboard base system board (4) until it rests at an angle.
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15. Remove the keyboard base system board (5) by sliding it up and to the right at an angle.

Reverse this procedure to install the keyboard base system board.

Fingerprint reader board cable
NOTE: The fingerprint reader board cable is included in the Keyboard Base Cable Kit, spare part number 
793721-001.

Before removing the fingerprint reader board cable, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Remove the keyboard base battery (see Keyboard base battery on page 72).

6. Remove the keyboard system board (see Keyboard base system board on page 81).

Remove the fingerprint reader board cable:

1. Turn the keyboard base system board upside down with the front toward you.

2. Release the ZIF connector (1) to which the fingerprint reader board cable is attached, and then 
disconnect the fingerprint reader board cable from the keyboard base system board.
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3. Remove the fingerprint reader board cable (2).

The fingerprint reader board cable is included in the Keyboard Base Cable Kit, spare part number 
793721-001.

Reverse this procedure to install the fingerprint reader board cable.

Kickstand

Description Spare part number

Kickstand (includes rubber feet) 793715-001

Kickstand Hinge Kit 793716-001

Before removing the kickstand, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Disconnect the keyboard base battery cable from the keyboard base system board (see Keyboard base 
battery on page 72).

Remove the kickstand:

1. Remove the four Phillips PM2.0×2.5 broad head screws (1) that secure the kickstand to the top cover.
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2. Remove the kickstand (2).

Reverse this procedure to install the kickstand.

Hinge assembly

Description Spare part number

Hinge assembly (includes left and right cables) 793717-001

Before removing the hinge assembly, follow these steps:

1. Shut down the keyboard base. If you are unsure whether the keyboard base is off or in Hibernation, turn 
the keyboard base on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the keyboard base.

3. Disconnect the power from the keyboard base by first unplugging the power cord from the AC outlet 
and then unplugging the AC adapter from the keyboard base.

4. Remove the bottom cover (see Bottom cover on page 71).

5. Disconnect the keyboard base battery cable from the keyboard base system board (see Keyboard base 
battery on page 72).

6. Remove the kickstand (see Kickstand on page 85).

Remove the hinge assembly:

1. Release the adhesive strips (1) that secure the hinge assembly cables to the keyboard base 
system board.

2. Disconnect the hinge assembly cables (2) from the keyboard base system board.

3. Remove the four Torx8 T8M2.0×3.2 screws (3) that secure the hinge assembly to the top cover.
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4. Remove the two Phillips PM2.0×2.5 broad head screws (4) that secure the hinge assembly to 
the top cover.

5. Remove the hinge assembly (5).

Reverse this procedure to install the hinge assembly.
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7 Slate Setup (BIOS), MultiBoot, and HP PC 
Hardware Diagnostics (UEFI) – Windows 8

Using Slate Setup
Slate Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output 
devices on the system (such as disk drives, display, keyboard, mouse, and printer). Slate Setup includes 
settings for the types of devices installed, the startup sequence of the slate, and the amount of system and 
extended memory.

NOTE: Use extreme care when making changes in Slate Setup. Errors can prevent the slate from operating 
properly.

Starting Slate Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Slate Setup only if USB 
legacy support is enabled.

To start Slate Setup, follow these steps:

1. Turn on or restart the slate, and then press esc or hold down the volume button while the "Hold the 
Volume Down button to enter the BIOS Startup Menu" message is displayed at the bottom of the screen.

2. Press or tap f10 to enter Slate Setup.

Navigating and selecting in Slate Setup

To navigate and select in Slate Setup, follow these steps:

1. Turn on or restart the slate, and then press esc or hold down the volume button while the "Hold the 
Volume Down button to enter the BIOS Startup Menu" message is displayed at the bottom of the screen.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard 
to navigate and make selections in Slate Setup.

2. Press or tap f10 to enter Slate Setup.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press 
enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the 
screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Slate Setup screen, press esc, and then follow 
the on-screen instructions.

To exit Slate Setup menus, choose one of the following methods:

● To exit Slate Setup menus without saving your changes:

Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –
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Select Main > Ignore Changes and Exit, and then follow the on-screen instructions.

● To save your changes and exit Slate Setup menus:

Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.

– or –

Select Main > Save Changes and Exit, and then follow the on-screen instructions.

Your changes go into effect when the slate restarts.

Restoring factory settings in Slate Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Slate Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the slate, and then press esc or hold down the volume button while the "Hold the 
Volume Down button to enter the BIOS Startup Menu" message is displayed at the bottom of the screen.

2. Press or tap f10 to enter Slate Setup.

3. Use a pointing device, the arrow keys, or touch the screen to select Main > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then 
follow the on-screen instructions.

– or –

Select Main > Save Changes and Exit, and then follow the on-screen instructions.

Your changes go into effect when the slate restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing 
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on 
the slate, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if 
you are already in Windows) or by using Slate Setup.

1. Start Slate Setup.

2. Use a pointing device, the arrow keys, or touch the screen to select Main > System Information.

3. To exit Slate Setup without saving your changes, click the Exit icon in the lower-right corner of the 
screen, and then follow the on-screen instructions.

– or –

Select Main > Ignore Changes and Exit, and then follow the on-screen instructions.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the slate or an unsuccessful installation, download and install a 
BIOS update only when the slate is connected to reliable external power using the AC adapter. Do not 
download or install a BIOS update while the slate is running on battery power, docked in an optional docking 
device, or connected to an optional power source. During the download and installation, follow these 
instructions:

Do not disconnect power on the slate by unplugging the power cord from the AC outlet.

Do not shut down the slate or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting Start > Help and Support.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on 
your slate. Make a note of the date, name, or other identifier. You may need this information to 
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard 
drive where the BIOS update is downloaded. You will need to access this path when you are ready 
to install the update.

NOTE: If you connect your slate to a network, consult the network administrator before installing any 
software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download 
is complete. If no instructions are revealed, follow these steps:
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1. Select Start > Slate.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the 
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file 
from your hard drive.

Synchronizing the slate and keyboard
When you attach the slate to the keyboard and restart the slate, the BIOS checks to see if the Embedded 
Controller firmware on the keyboard needs to be synchronized, and will start the synchronization. If the 
synchronization is interrupted, a notification screen displays for 10 seconds before the slate restarts and 
attempts to synchronize again.

NOTE: The Embedded Controller firmware will only synchronize if the slate or keyboard battery is more 
than 50% charged, or if your slate is connected to AC power.

Using MultiBoot

About the boot device order

As the slate starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is enabled 
at the factory, controls the order in which the system selects a boot device. Boot devices can include optical 
drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices contain 
bootable media or files that the slate needs to start and operate properly.

NOTE: Some boot devices must be enabled in Slate Setup before they can be included in the boot order.

You can change the order in which the slate searches for a boot device by changing the boot order in Slate 
Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed at the 
bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot devices and 
allows you to select a boot device. Or, you can use MultiBoot Express to set the slate to prompt you for a boot 
location each time the slate turns on or restarts.
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Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

● To set a new boot order that the slate uses each time it is turned on, by changing the boot order in Slate 
Setup.

● To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” 
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options 
menu.

● To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each 
time the slate is turned on or restarted.

Setting a new boot order in Slate Setup

To start Slate Setup and set a boot device order that the slate uses each time it is turned on or restarted, 
follow these steps:

1. Turn on or restart the slate, and then press esc or hold down the volume button while the "Hold the 
Volume Down button to enter the BIOS Startup Menu" message is displayed at the bottom of the screen.

2. Press or tap f10 to enter Slate Setup.

3. Use a pointing device, the arrow keys, or touch the screen to select the Legacy Boot Order list, and then 
press enter.

4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

– or –

To move the device down in the boot order, use a pointing device to click the down arrow, or press the - 
key.

5. To save your changes and exit Slate Setup, click the Save icon in the lower-left corner of the screen, and 
then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then follow the on-screen instructions.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the slate, and then pressing esc or hold 
down the volume button while the "Hold the Volume Down button to enter the BIOS Startup Menu" 
message is displayed at the bottom of the screen.

2. Press f9.

3. Use a pointing device, the arrow keys, or touch the screen to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Slate Setup and set the slate to display the MultiBoot startup location menu each time the slate is 
started or restarted, follow these steps:

1. Turn on or restart the slate, and then press esc or hold down the volume button while the "Hold the 
Volume Down button to enter the BIOS Startup Menu" message is displayed at the bottom of the screen.

2. Press or tap f10 to enter Slate Setup.

3. Use a pointing device, the arrow keys, or touch the screen to select System Configuration > Boot 
Options, and then press enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the 
slate to display the startup location menu before it defaults to the current MultiBoot setting. (When 0 is 
selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Slate Setup, click the Save icon in the lower-left corner of the screen, and 
then follow the on-screen instructions.

– or –

Select Main > Save Changes and Exit, and then follow the on-screen instructions.

Your changes go into effect when the slate restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, 
and then press enter.

● To prevent the slate from defaulting to the current MultiBoot setting, press any key before the allotted 
time expires. The slate will not start until you select a boot device and press enter.

● To allow the slate to start according to the current MultiBoot settings, wait for the allotted time to 
expire.

Using HP PC Hardware Diagnostics (UEFI) (select models only)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run 
diagnostic tests to determine if the slate hardware is functioning properly. The tool runs outside of the 
operating system to isolate hardware failures from issues that may be caused by the operating system or 
other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the slate, quickly press esc, and then press f2.

After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools in the 
following order:

a. Connected USB drive
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NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading 
HP PC Hardware Diagnostics (UEFI) to a USB device on page 94.

b. Hard drive

c. BIOS

2. Use the keyboard arrow keys to select the type of diagnostic test you want to run, and then follow the 
on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.

There are two options to download HP PC Hardware Diagnostics to a USB device:

Option 1: HP PC Diagnostics homepage— Provides access to the latest UEFI version

1. Go to http://hp.com/go/techcenter/pcdiags.

2. Click the UEFI Download link, and then select Run.

Option 2: Support and Drivers page—Provides downloads for a specific product for earlier and later 
versions

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your slate model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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8 Specifications

 Metric U.S.

Slate dimensions

Width 29.80 cm 11.73 in

Depth 19.27 cm 7.59 in

Height 1.07 cm 0.42 in

Weight 0.82 kg 1.80 lbs

System (slate and keyboard base) dimensions

Width 29.80 cm 11.73 in

Depth 20.42 cm 8.04 in

Height 2.08 cm 0.82 in

Weight 1.54 kg 3.40 lbs

Input power

Operating voltage and current 19.5 V dc @ 2.31 A – 45 W

19.5 V dc @ 3.33 A – 65 W

19.5 V dc @ 4.62 A – 90 W

19.5 V dc @ 10.25 A – Slim 200 W

19.5 V dc @ 11.79 A – Slim 230 W

NOTE: This product is designed for IT power systems in Norway with phase-to-phase voltage not exceeding 240V rms.

NOTE: The slate operating voltage and current can be found on the system regulatory label.

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating ‑20°C to 60°C ‑4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating ‑15 m to 3,048 m ‑50 ft to 10,000 ft

Nonoperating ‑15 m to 12,192 m ‑50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this range of 
temperatures.
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9 Backup and recovery – Windows 8

To protect your information, use Windows backup and restore utilities to back up individual files and folders, 
back up your entire hard drive, create system repair media (select models only) by using the installed optical 
drive (select models only) or an optional external optical drive, or create system restore points. In case of 
system failure, you can use the backup files to restore the contents of your slate.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Windows Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later 
use.

NOTE: Windows includes the User Account Control feature to improve the security of your slate. You may 
be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. For more information, see Windows Help and Support.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair 
media and your initial backup immediately after initial system setup. As you add new software and data files, 
you should continue to back up your system on a regular basis to maintain a reasonably current backup.

For more information on the Windows backup features, see Windows Help and Support.

Performing a system recovery
In case of system failure or instability, the slate provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The 
image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your slate and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows operating system media to reboot the 
slate and repair the operating system. For additional information, see Using Windows operating system 
media (purchased separately) on page 98.
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Using the Windows recovery tools

To recover information you previously backed up, see Windows Help and Support for steps on restoring files 
and folders.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have 
created and any software installed on the slate are permanently removed. When reformatting is complete, 
the recovery process restores the operating system, as well as the drivers, software, and utilities from the 
backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

From the Start screen, type file, and then click File Explorer.

– or –

From the Start screen, type pc, and then select This PC.

NOTE: If the Windows partition and the Recovery Image partition are not listed, you must recover your 
operating system and programs using the Windows operating system DVD and the Driver Recovery 
media (both purchased separately). For additional information, see Using Windows operating system 
media (purchased separately) on page 98.

3. If the Windows partition and the Recovery Image partition are listed, restart the slate by pressing and 
holding the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search for 
these topics in Windows Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the slate are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc, and 
then select This PC.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and 
programs using the Windows operating system media and the Driver Recovery media (both purchased 
separately). For additional information, see Using Windows operating system media (purchased 
separately) on page 98.

3. If the Recovery Image partition is listed, restart the slate, and then press esc or hold down the volume 
button while the “Hold the Volume Down button to enter the BIOS Startup Menu” message is displayed 
at the bottom of the screen.

4. Press or tap f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers booklet 
included with the slate. You can also find contact information from the HP website. Go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

CAUTION: Using a Windows operating system media completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the slate are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.

To initiate a full install of the operating system using a Windows operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows operating system DVD into the optical drive, and then restart the slate.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

98 Chapter 9   Backup and recovery – Windows 8

http://www.hp.com/support


Using Windows Refresh or Windows Reset

When your slate is not working properly and you need to regain system stability, the Windows Refresh option 
allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your slate, or remove personal 
information before you give away or recycle your slate. For more information on these features, see 
Windows Help and Support.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from 
the system.

1. From the Start screen, type HP Software Setup.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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10 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring 
nonvolatile memory that can contain personal data after the system has been powered off and the hard drive 
has been removed.

HP Business Notebook PC products that use Intel-based or AMD®-based system boards contain volatile DDR 
memory. The amount of nonvolatile memory present in the system depends upon the system configuration. 
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally 
shipped from HP assuming that no subsequent modifications have been made to the system and assuming 
that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, 
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain 
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the 
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed 
in the Maintenance and Service Guides available for HP PC products available on the product support pages at 
www.hp.com.

1. Follow steps (a) through (I) below to restore the nonvolatile memory that can contain personal data. 
Restoring or re-programming nonvolatile memory that does not store personal data is neither 
necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the 
bottom of the display, or press the ESC key to display the start up menu, then press F10 . If the 
system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu. 
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the 
tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select 
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing 
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this 
procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic 
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if 
more than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning 
message.

h. Select the File menu, then Save Changes and Exit.

i. Reboot the system. If the system has a Trusted Platform Module and/or fingerprint sensor, one or 
two prompts will appear: one to clear the TPM and the other to reset fingerprint sensor. Press F1 
to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel Centrino with VProTM, 
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System 
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Configuration, then AMT Options. Then select Un-configure AMT on next boot. Select Save, then 
Yes. Select the File menu, and then select Save Changes and Exit. Reboot the system and confirm 
that you want to un-configure AMT.

j. If the optional Intel Anti-Theft Technology (AT) was activated, contact the provider to deactivate it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated 
on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that, 
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when 
prompted near the bottom of the display, or press ESC to display the start up menu, then press 
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and 
select the desired drive. For a higher level of protection, select Optimum.

NOTE: This process will take a long time, and the amount of time varies based on the hard drive 
capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third 
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by 
powering on the system and pressing F10 when prompted near the bottom of the display. Select 
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the 
desired hard drive.
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Non-volatile memory usage

Non Volatile 
Memory Type

Amount (Size) Does this 
memory store 
customer data?

Does this 
memory retain 
data when 
power is 
removed?

What is the 
purpose of this 
memory?

How is data 
input into this 
memory?

How is this 
memory write 
protected?

Real Time Clock 
(RTC) battery 
backed-up CMOS 
configuration 
memory (CMOS)

256 Bytes No Yes Stores system 
date and time 
and limited 
keyboard 
controller data.

Using the F10 
Setup utility or 
changing the 
Microsoft 
Windows date 
and time.

This memory is 
not write-
protected. HP 
recommends 
password 
protecting the 
F10 Setup 
utility.

Controller (NIC) 
EEPROM

64 KBytes (not 
customer 
accessible)

No Yes Store NIC 
configuration 
and NIC 
firmware.

Using a utility 
from the NIC 
vendor that can 
be run from DOS.

A utility is 
required to write 
data to this 
memory and is 
available from 
NIC vendor. 
Writing data to 
this ROM in an 
inappropriate 
manner will 
render the NIC 
nonfunctional.

Keyboard ROM 64 KBytes (not 
customer 
accessible)

No Yes Stores firmware 
code (keyboard, 
mouse, & 
battery 
management).

Programmed at 
the factory. 
Code is updated 
when the system 
BIOS is updated.

A utility is 
required for 
writing data to 
this memory and 
is available on 
the HP website. 
Writing data to 
this ROM in an 
inappropriate 
manner can 
render the PC 
nonfunctional.

DIMM Serial 
Presence Detect 
(SPD) 
configuration 
data

256 Bytes per 
memory 
module, 128 
Bytes 
programmable 
(not customer 
accessible)

No Yes Stores memory 
module 
information.

Programmed by 
the memory 
vendor.

Data cannot be 
written to this 
memory when 
the module is 
installed in a PC. 
The specific 
write protection 
method varies 
by memory 
vendor.

System BIOS 4 to 5 MBytes Yes Yes Store system 
BIOS code and 
PC configuration 
data.

System BIOS 
code is 
programmed at 
the factory. 
Code is updated 
when the system 
BIOS is updated. 
Configuration 
data and 
settings are 

A utility is 
required for 
writing data to 
this memory and 
is available on 
the HP website. 
Writing data to 
this ROM in an 
inappropriate 
manner can 
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Non Volatile 
Memory Type

Amount (Size) Does this 
memory store 
customer data?

Does this 
memory retain 
data when 
power is 
removed?

What is the 
purpose of this 
memory?

How is data 
input into this 
memory?

How is this 
memory write 
protected?

input using the 
F10 setup utility 
or a custom 
utility.

render the PC 
nonfunctional.

Intel 
Management 
Engine Firmware 
(present only in 
models ending in 
a ‘p’ or ‘w’ or 
with Intel 
Centrino Pro 
technology)

1.5 or 5 MBytes Yes Yes Stores 
Management 
Engine Code, 
Settings, 
Provisioning 
Data and iAMT 
third party data 
store.

Management 
Engine Code is 
programmed at 
the factory. 
Code is updated 
via Intel secure 
firmware update 
utility. Unique 
Provisioning 
Data can be 
entered at the 
factory or by an 
administrator 
using the 
Management 
Engine (MEBx) 
setup utility. The 
third party data 
store contents 
can populated 
by a remote 
management 
console or local 
applications 
registered by an 
administrator to 
have access to 
the space.

The Intel chipset 
is configured to 
enforce 
hardware 
protection to 
block all direct 
read/write 
access to this 
area. An Intel 
utility is required 
for updating the 
firmware. Only 
firmware 
updates digitally 
signed by Intel 
can be applied 
using this utility.

Bluetooth flash 2 MBits No Yes Stores Bluetooth 
configuration 
and firmware.

Programmed at 
the factory. 
Tools for writing 
data to this 
memory are not 
publicly 
available but can 
be obtained 
from the silicon 
vendor.

A utility is 
required for 
writing data to 
this memory and 
is made 
available 
through newer 
versions of the 
driver if the flash 
requires an 
upgrade.

802.11 WLAN 
EEPROM

4 KBytes to 8 
KBytes

No Yes Stores 
configuration 
and calibration 
data.

Programmed at 
the factory. 
Tools for writing 
data to this 
memory are not 
made public.

A utility is 
required for 
writing data to 
this memory and 
is typically not 
made available 
to the public 
unless a 
firmware 
upgrade is 
necessary to 
address a unique 
issue.
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Non Volatile 
Memory Type

Amount (Size) Does this 
memory store 
customer data?

Does this 
memory retain 
data when 
power is 
removed?

What is the 
purpose of this 
memory?

How is data 
input into this 
memory?

How is this 
memory write 
protected?

Webcamera 64 KBits No Yes Store 
webcamera 
configuration 
and firmware.

Using a utility 
from the device 
manufacturer 
that can be run 
from Windows.

A utility is 
required for 
writing data to 
this memory and 
is typically not 
made available 
to the public 
unless a 
firmware 
upgrade is 
necessary to 
address a unique 
issue.

Fingerprint 
reader

512 KBytes flash Yes Yes Stores 
fingerprint 
templates.

By enrolling in 
HP ProtectTools 
Security 
Manager.

Only a digitally 
signed 
application can 
make the call to 
write to the 
flash.

Questions and answers
1. How can the BIOS settings be restored (returned to default settings)?

a. Turn on or restart the slate and press F10 when prompted near the bottom of the display.

b. Select File, then select Restore defaults.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory 
module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number, 
data width, speed/timing, voltage and thermal information. This information is written by the module 
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is 
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is 
not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so 
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the 
write function.

4. In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can 
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.
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5. What is meant by “Restore the nonvolatile memory found in Intel-based system boards?”

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. Does resetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not 
reset many of the system data and configuration defaults to their default settings. To return these 
system data and configuration defaults to default settings, refer to question and answer 1 and follow 
the instructions for returning the BIOS settings to factory defaults.
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11 Backup and recovery – Windows 7

Your slate includes HP and Windows tools to help you safeguard your information and retrieve it if you ever 
need to. These tools will help you return your slate to a proper working state, all with simple steps. This 
section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the slate, create HP Recovery media. This step creates a Windows 7 
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original 
operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery 
DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc 
Creator on page 106.

2. Use Windows Backup and Recovery tools to perform the following:

● Back up individual files and folders

● Back up your entire hard drive (select models only)

● Create system repair discs (select models only) with the installed optical drive (select models only) 
or an optional external optical drive

● Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details 
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and 
Support.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of 
system instability.

In case of system failure, you can use the backup files to restore the contents of your slate. See Backing up 
your information on page 107.

Guidelines

● When creating recovery media or backing up to discs, use any of the following types of discs (purchased 
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the 
type of optical drive you are using.

● Be sure that the slate is connected to AC power before you start the recovery media creation process or 
the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. 
After you successfully set up the slate, you can create recovery media using HP Recovery Disc Creator. This 
recovery media allows you to reinstall your original operating system as well as select drivers and 
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applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery 
DVDs:

● Windows 7 operating system DVD—Installs the operating system without additional drivers or 
applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP 
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that 
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you 
add new software and data files, you should continue to back up your system on a regular basis to maintain a 
reasonably current backup. You should also create Windows system repair media (select models only) which 
can be used to start up (boot) the slate and repair the operating system in case of system instability or 
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your 
settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in 
Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your slate. You may 
be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.
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To create a backup using Windows Backup and Restore:

NOTE: The backup process may take over an hour, depending on file size and the speed of the slate.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or 
create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the slate provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent 
Windows from starting correctly.

● f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard 
drive image. The image includes the Windows operating system and software programs installed at the 
factory.

NOTE: If you are unable to boot (start up) your slate and you cannot use the system repair media you 
previously created (select models only), you must purchase Windows 7 operating system media to reboot the 
slate and repair the operating system. For additional information, see Using Windows 7 operating system 
media on page 109.

Using the Windows recovery tools 

Using the Windows recovery tools, you can:

● Recover individual files

● Restore the slate to a previous system restore point

● Recover information using recovery tools

NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics 
in Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: Windows includes the User Account Control feature to improve the security of your slate. You may 
be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and 
Support.

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your slate (select models only), or 
your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have 
created and any software installed on the slate are permanently removed. When reformatting is complete, 
the recovery process restores the operating system, as well as the drivers, software, and utilities from the 
backup used for recovery.
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1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Slate.

NOTE: If the Windows partition is not listed, you must recover your operating system and programs 
using the Windows 7 operating system DVD and the Driver Recovery media. For additional information, 
see Using Windows 7 operating system media on page 109.

3. If the Windows partition is listed, restart the slate, and then press f8 before the Windows operating 
system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, select Start > Help 
and Support.

Using f11 recovery tools (select models only)

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you 
have created and any software that you have installed on the slate are permanently removed. The f11 
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. 
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Slate, click 
Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and 
programs using the Windows 7 operating system media and the Driver Recovery media. For additional 
information, see Using Windows 7 operating system media on page 109.

3. If the HP Recovery partition is listed, restart the slate, and then press esc while the “Press the ESC key 
for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select 
models only), you must purchase a Windows 7 operating system DVD to reboot the slate and repair the 
operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to 
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the 
Worldwide Telephone Numbers booklet included with the slate.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats 
the hard drive. All files that you have created and any software that you have installed on the slate are 
permanently removed. When reformatting is complete, the recovery process helps you restore the operating 
system, as well as drivers, software, and utilities.
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To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the slate, and then insert the Windows 7 operating system DVD into the optical drive before the 
Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your slate.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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12 Power cord set requirements

The wide-range input feature of the slate permits it to operate from any line voltage from 100 to 120 volts 
AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the slate meets the requirements for use in the country or 
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region 
where the slate is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in 
the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 
125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet 
C13 connector for mating with the appliance inlet on the back of the slate. Requirements for all 
countries 113

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

Requirements for all countries 111



Country/region Accredited agency Applicable note number

South Korea EK 4

Sweden CEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be 
used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the 
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must 
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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13 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the 
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/
recycle.
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description 2

primary storage, product 
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removal 64, 67, 68
spare part numbers 64, 67, 68

wireless light 11
wireless, product description 1, 2
WLAN antenna

location 8
removal 67
spare part numbers 19, 67

WLAN module
removal 37
spare part numbers 18, 37

workstation guidelines 29
WWAN antenna

location 8
removal 64
spare part numbers 19, 64

WWAN module
removal 39
spare part numbers 18, 39

116 Index


	Product description
	External component identification
	Slate edge components
	Slate display components
	Keyboard base
	Keys
	Lights
	TouchPad
	Left side
	Right side

	Illustrated parts catalog
	Locating the product name, serial number, product number, warranty information, and model name
	Slate major components
	Keyboard base
	Miscellaneous parts

	Removal and replacement preliminary requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines





	Removal and replacement procedures – slate
	Unlocking the device and disabling Always On Remote Management (select HP devices only)
	Display panel assembly
	Battery
	WLAN module
	WWAN module
	Speakers
	Vibrator module
	Fan
	Volume button board
	Docking connector board
	Audio jack board
	System board
	Volume button board cable
	RTC battery
	Solid-state drive
	Heat sink
	Rear-facing webcam
	Front-facing webcam
	WWAN antenna
	WLAN antenna
	WiGig antenna
	Docking connector board cable

	Removal and replacement procedures – Keyboard base
	Bottom cover
	Keyboard base battery
	Power connector cable
	Keyboard
	Fingerprint reader board
	TouchPad
	Smart card reader board
	Connector board
	Keyboard base system board
	Fingerprint reader board cable
	Kickstand
	Hinge assembly

	Slate Setup (BIOS), MultiBoot, and HP PC Hardware Diagnostics (UEFI) – Windows 8
	Using Slate Setup
	Starting Slate Setup
	Navigating and selecting in Slate Setup
	Restoring factory settings in Slate Setup
	Updating the BIOS
	Determining the BIOS version
	Downloading a BIOS update


	Synchronizing the slate and keyboard
	Using MultiBoot
	About the boot device order
	Choosing MultiBoot preferences
	Setting a new boot order in Slate Setup
	Dynamically choosing a boot device using the f9 prompt
	Setting a MultiBoot Express prompt
	Entering MultiBoot Express preferences


	Using HP PC Hardware Diagnostics (UEFI) (select models only)
	Downloading HP PC Hardware Diagnostics (UEFI) to a USB device


	Specifications
	Backup and recovery – Windows 8
	Backing up your information
	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools
	Using Windows operating system media (purchased separately)
	Using Windows Refresh or Windows Reset
	Using HP Software Setup


	Statement of Volatility
	Non-volatile memory usage
	Questions and answers

	Backup and recovery – Windows 7
	Creating recovery media and backups
	Guidelines
	Creating recovery media with HP Recovery Disc Creator
	Creating recovery media

	Backing up your information

	Performing a system recovery
	Using the Windows recovery tools
	Using f11 recovery tools (select models only)
	Using Windows 7 operating system media


	Power cord set requirements
	Requirements for all countries
	Requirements for specific countries and regions

	Recycling
	Index

